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Welcome

Central East ATTC and PTTC Webinar

The 5 C’s (not D’s) of Data

( THE DANYA INSTITUTE

The Central East ATTC, MHTTC, and PTTC are housed at
the Danya Institute in Silver Spring, MD

Renata Henry
Executive Director
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TT Technology Transfer Centers

Funded by Substance Abuse and Mental Health Services Administration

Each TTC Network includes 13 centers.*

(= N [w

=26 ATTC Network Coordinating Office
=3

National American Indian and Alaska

MHTTC| — Native Center

S

National Hispanic and Latino Center

PTTC

/ 10 Regional Centers (aligned with HHS regions)

—

-

—_é‘ Central East (HHS Region 3) .' .a Central East (HHS Region 3)
= - A
gg ATTC Ne_ o)/ PTTC 3



https://www.samhsa.gov/technology-transfer-centers-ttc
https://attcnetwork.org/
https://mhttcnetwork.org/
https://pttcnetwork.org/
https://www.samhsa.gov/technology-transfer-centers-ttc
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I The use of affirming language inspires hope.
LANGUAGE MATTERS.

PEOPLE FIRST.

The PTTC Network uses affirming language to promote the application
of evidence-based and culturally informed practices.
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Eligibility

Behavioral health and health care providers,
consumers, families, state and local public
health systems and other stakeholders

Consistent with
Regional, State

Data Driven

and Local
Needs

EBPs provided
by Subject

Matter Experts




The Five C’s
(not D’s) of Data

Jamie Comstock
& Robin Carr
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As we gather in this place, we want to
acknowledge that we are occupying the
traditional territory and ancestral lands
of the Wabanaki people, who for
thousands of years have called this place
home. We acknowledge their continued
connection to this land, give thanks for
allowing us to do this good work on their
homeland, and remember their
ancestors who were here before us.
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Denise Altvater, Passamaquoddy Tribe at Sipayik



Search Log In LRV

mattsurelee & m

1,628 posts 400k followers 308 following

Matt Shirley

| try to make a chart every day [l

Email me things: mattsurelee@gmail.com

| wrote a book
www.runningpress.com/titles/matt-shirley/a-visual-learners-guide-to-being-a-gro...
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THE WORST ATTRACTION IN EVERY STATE

ACCORDING TO @MATTSURELEE’S INSTAGRAM FOLLOWERS
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BELIEFS | STAND BY

How steadfast it is

Data that go The latest Unconventional New That thing | heard
against my scientific thinking evidence from my friend’s
opinions studies brother in 1993



Starting a Fight

*shokes their

What are s

you doing?

Seeing Someone
Whose Name You
Don’t Remember

Who are
you here
with?

Where do
you live?

Do you Do you want
want fo go o °": to call your
outside? SRS mommy?

Consoling




WHEN CHILDREN
LACK NUTRITION

This is childhood malnutrition at life-size: Each of
these children is severely malnourished—and the
red circle around each photo equals the circumfer-
ence of that child’s arm. The circle is much larger if

a child is not malnourished, as the key below shows.

Dg;pitg some gains against g!obal hunger, mal- East Ghouta e Chafhsy
nutrition in children under age hvg left 22.2 percent SYRIA, 2017 SOUTH SUDAN, 2017 PAKISTAN, 2015
of them stunted (too short for theirage) and 7.5
percent of them wasted (too thin for their height) s hrrded iR ok oo Exremeh
in 2017. UNICEF's Diane Holland says catching acute c¢ 4 3
malnutrition early is key to bringing children back Lo
to healthy growth. The “MUAC bracelet” (right), r jularly
used to measure mid-upper-arm circumference, :
helps gauge the severity of acute malnutrition so
a child can be given lifesaving treatment and care.

vho live there,

MUAC (MID-UPPER-ARM CIRCUMFERENCE)

Dhamar Muna Garage IDP camp oinerghona jee camp

YEMEN, 2017 NIGERIA, 2016 BANGLADESH, 2017

-12.5Cm
MODERATE ACUTE

MALNUTRITION a5 3 result of th

Haram conflict. Wid\
old's family left Myanmar
after the ¢ s military
onger operate. o set fire to their village.

HUNGRIEST
COUNTRIES

Food scarcity and
malnutrition span the
globe. Of the 50 coun-
tries with the highest
percentage of children
under age five suffering
from malnutrition, more
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than half are in Africa.
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Why do it
differently?
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We want the audience

to understand the data we share.




A Before and After Transformation...

and some terminology

Attendee Breakfast Preferences

3D ‘///gndhnes

Just a pile of bacon
W Eggs

"

Bagel |
q ®m Pancakes
Fruitsalad |
1 M Cereal
Don't eat breakfast |

Cereal | = Don't eat breakfast
Pancakes 1‘ = Fruit salad
Eggs ! W Bagel

Just a pile of bacon

20% :
30%\

legend

‘\ N\
tick marks

title

subtitle
\Zreakfast preferences focus on protein.

ne in ten fellow attendees do not consume
adequate energy for their first meal of the day.

Eggs

Just a pile of bacon

23%
21%

Cereal 16%

14%
Don't eat breakfast Jler
8%

Fruit salad 8% .
action
N color
?fi numeric
aness labels



What’s the point?

@




MAKING ECISION
i [

Asking the following questions can help you decide what data to include in your presentation versus

what might be better suited for a handout or left out altogether.

What are the conclusions that can be drawn about the data?

What's compelling about this information?

Avre there trends to show?

Are there comparisons you'd like to demonstrate?

Is there anything surprising or unexpected to share?

@ 2016 Info Inspired. Some Rights Reserved.




Chart Choice
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Datavizproject.com

&« c & datavizproject.com/# h* 4 f". oI G |

ALL  FAMILY -~ INPUT ~ FUNCTION ~ SHAPE~ Q © ferdio

Concept visualisation Distribution M Geographical data
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Icon Array Pie/Donut Bar/Column
® B CHART CHOOSER 3.0
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Sausage

Most Popular Pasta Sauces

Vodka Marinara

Marinara

Sausage

Mushroom

Alfredo Mushroom

Pie Chart VS. Bar Chart




States with bills currently active in state legislatures that mandate people use
sex-segregated facilities according to sex assigned at birth rather than gender identity

I Bill targets public schools M Bill targets general public Maine
Alaska Vt. N.H. Mass.
Wash. Mont. N.D. Mich. NY. Conn. R.l.
Ore. Idaho Wyo. Ind. Ohio Pa. N.J.
Calif. Nev. Utah  Colo. W.Va. Md. Del. DC
Ariz. N.M. Va. MARCH 23

Governor signed law requiring
schools and public buildings
Hawaii Texas La. Miss. Ala. Ga. SIC: to segregate facilities according
to sex marked on birth certificates.
Fla. l

South Carolina is considering a bill preventing
transgender students from playing on athletic
eams that match their gender identity.
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Number of Maine Microbreweries and Brewpubs

by County
Aroos
Pisc
Frank | Ken Wash
Oxf | Andro | Sag Knox
[J D 0
1
2
W 3-4
B 5-8
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B 5+



Who are the Drinkers in 2016?

Millennials continue to account
for a majority of the drinkers

0% 20

% 40% 60% 80%
Total Population 21+ | Millennials: 29% - Baby Boomers: 35%

Weekly Beer Drinkers Millennials: 41% - Boomers: 27%
Drinkers >

Matures

100%



Most Popular Pasta Sauces




Which visualization makes
sense for this data?




Composition




Substance Use in Past Month Among Pregnant Women

PAST MONTH, 2015 - 2017, 15- 44
ILLICIT DRUGS TOBACCO PRODUCTS ALCOHOL
334K
319K 14.7%
13.9% 261K
11.5%
239K 214K
10.6% 9.3%
194K 187K
143K " 8.3%
109 A
4.7%
2015 2016 2017 2015 2016 2017 2015 2016 2017
161K
78K 1&19‘!:( 7.1%
3.4% —
o w0 26K = ?EK
o 19K o 1.2% o .
o~ 0.8% ™~ o~ 8K
2K
- u‘! Uﬁ, o 0.4%
Marijuana Opioids Cocaine Marijuana Opioids Cocaine Marijuana Opioids Cocaine
. . Difference between this estimate and the 2017
Special analysis of the 2017 NSDUH Report. * R . L. .
estimate is statistically significant at the .05 level. S ' ' ' S '
17 Substance Abuse aﬁal Health
Services Administration




More Women Using

Cannabis During Pregnancy

Rates more than doubled in a four year span.

%

5%

3%

2013 2015 2017



SHARP2019  substance Use

State-identified priority substance use - Cigarettes and vaping products
State of Utah 2019 Student Survey
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* Since not all students answer all questions, the percentage of students reporting use in the past 30 days may be greater than the percentage reporting lifetime we.
** Natlonal comparison data are available for 8th, 10th, and 1 2th grade onky. Monitoring the Future does not survey Gth graders.

[ State 2015 [ State 2017 [ State 2019 & MTF**

2019 Prevention Needs Assessment Survey 11




getting addicted
because of:

nicotine.”

Stuart Hudnall,
Assistant Principal at
Herriman High School

of middle and high

0 school students
O reported vaping in

the past 30 days.



The Facts about

w N
5% 15%
6" Graders 8th Graders

Have tried vaping at least once

250) 32%

10th Graders 12th Graders

SOURCE: UTAH SHARP 2019




37,767

students are struggling
with nicotine addiction in
our state right now.

This is about the
population of Cedar City.




People read left to right,
top to bottom.

Icon by FreePik



Color

Adobe Color EXPLORE




Vary lightness to
communicate value

Lower Higher
Darker



ACTION
Color

title

Breakfast preferences focus on protein.
\Qne in ten fellow attendees do not consume
adequate energy for their first meal of the day.

Eggs
Just a pile of bacon

Cereal 16%

14%
Don't eat breakfast A
8%

Fruit salad 8% .
action
X color
data numeric
labels

labels

23%



THE STATE OF TOBACCO USE IN MAINE

Penobscot County Profile

CURRENT CIGARETTE SMOKING RATES

More than 21 in 100 adults in Penobscot County PENOBSCOT COUNTY
17in 100 adults in Maine ADULT SMOKING RATE
adults in the 21 20/
. 0 (MAINET7.3%)
3rd HIGHEST
RATE IN MAINE

If Pencbscot County's current cigarette rate among adults was
on par with the national average, 10,954 fewer adults would
smoke. This is about the population of Crono.

TOBACCO INDUSTRY INFLUENCE IN MAINE

Oi PPN

Tobacco Companies’ Annual 458 State Spending on
Marketing Spending in Maine MILLION Tobacco Prevention

ADULT TOBACCO USE DISPARITIES

Current smoking rates are higher among adults
with mental illness.

0
People with a behavioral health condition are not only 23.3%
more likely to smoke, they also smoke more frequently
They account for 25% of the adult population, but they

. . Current smoking rate
consume 40% of cigarettes sold in the U.S

among adults with no
mental illness

32%

Current smoking rate
among adults with

any mental illness




Projected Sales 2017-2021

21.6
/ 174 Biien
Billion
14.1
10.9 Billion
8.1 Billion

Billion




Projected Sales 2017-2021

21
/ 17 Sl
Billion
14
10 Billion
3 Billion

Billion




Color Scheme Brainstorming




Wow!
A million dollars!




N\

Marijuana Tax
Revenue W

Makes up less

than 1% of total

general

fund revenue

General Fund Revenue



DELICIOUS

MILK CHOCOLATE

(43
Grams)



' 'm 1\57“% |

Mle' M

@f COOL W I‘wlT MILK CHOCOLATE

100 milligrams of THC

20 Joints from the 1970s






(1101) sama1eSio Jo suol|ig

= =] <
=] LA — g
I L _

250

e

/

-
- —
-—-———.'--

= = = =
vt WO -+ Lt

100

sa11aa8 mqu JO SUOTqTd

Eeypt ——Nigeria ——South Africa ——Kenva —Total (22 countries)

—Algeria



5 &G B8 & &

LA

2011

NNEPC ME Exposure Cases Involving Only Marijuana
Age Group by Year
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Exposure cases involving marijuana only
peaked in 2019

30

25

20

15

10

2018

2019

6-12

13-19

2020



Poisoning Calls Related to
E-Cigarettes Have Skyrocketed

3,500

E-Cigarette Device and
Liquid Nicotine
Reported Exposures
to Poison Centers




Poisoning calls related to e-cigarettes
increased 1,360% from 2014 to 2017

2014
2015

2016
2017




Annual grocery store inflation by city, 2014

In 2014, food price inflation was higher in Seattle, St. Louis, Chicago,
and Atlanta than in other metropolitan areas

Percent change
35

Annual percent change
B <2% [ 2t03% Il > 3%

S alyc
4

3.0 1

2.5 1

2.0

1.5 1

1.0 -

0.5

0.0~

Source: Calculated by ERS, USDA, using Bureau of Labor Statistics (BLS) data.

Chart credit: USDA Economic Research Service



2014 Annual grocery store inflation by city

Food pnce inflation was higher in Seattle, St Louis, Chicago, and Atlanta than in other metropolitan areas

Annual % Chyg
= 2% B 2% =%
Hat Avg %

51, Lowis = 1%

Seatthe = 1%

Atlanta 20 3%
Chicago 210 3%
Detroit 210 3%
Houston 2103%

Los Angeles  2to 1%

New York  <2% 18 ;
Anchorage =% 1.1
Pittsburgh = 2% 0B :

Chart credit: Melissa Yu, BlueGranite.com, 6/3/2016
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Find
the hook.
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Resources




A Visualization Guide I
[ |

Design for lay audiences.
Statistical information can easily overwhelm. Gear all design toward lay audiences.
Remember people look for comparisons and themes. Make them easy to see!
People read left to right, top to bottom. Avoid centering.
De-clutter! Remove grid lines and tick marks.
The more "noise" ...AKA extra info you can delete, the easier to interpret.
Titles and subtitles matter.
Make sure they're concise, interesting and at top left.
Spend time creating a title that creates a "hook" and conveys the main point.
Position at the top left, so it's read first.
Use color as a tool to your advantage.
Consider using an action color.
Select color palette that goes with the theme and/or appeals to your audience.
Use gradients of color: lowest value/lightest color - highest value/darkest color.
Limit the use of legends. Avoid whenever possible.
Example: when creating a bar chart, place horizontal labels beside or on the bars.

Select the right data visualization for the job.

There are many online resources for deciding whether a pie chart,
line graph, or bar chart, etc makes the most sense.

Present in 2D.

3D charts may look more sophisticated, but experts agree they are harder to read.
Use round numbers.

Round to the nearest whole number for the quickest, easiest transfer of information.
Put it in context.

Numbers are meaningful when we understand them in relation to the total picture.

© 2020 Info Inspired. Some Rights Reserved.




the

truthful

Data Visualization Tutorials with

Alberto Cairo

38 videos * 1,823 views * Last updated on Sep 1, 2019

= A ~»

(x Erin Malone

SUBSCRIBE

the
truthful
art

the
truthful
art

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art".

Alberto Cairo

Designing the graphics in "The Truthful Art"

1oL

1:2

1.3

1.4

1.5

1.6

. 2.1: PIVOT TAB
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MIMI The Library of Missing Datasets 2.0 (2018)

nstallation piece

ONUOHA

recentwork
news Larger project here.

about

. contact r
The Library of

Missing Data Sets |[gereass

On Classification
The Point of Collection

Us. Aggregated

hat is Missing Is S
https://mimionuoha.com/ L

the-library-of-missing- Datasets
datasets-v-20 e




Google
Infographics
Toolbox

Template

https://docs.google.com/drawing
s/d/1mEjyhAjlTgzqlBxi9niAmVOnL
dmhbUZbGMziwHdRstg/template
/preview?usp=drive_web

Infographics Toolbox

LG



Microsoft Excel
Cheat Sheet

https://www.customguide.com
cheat-sheet/excel-cheat-sheet.pdf

Microsoft®

x ) Excel Cheat Sheet

Intermediate Skills

Chart Elements

Chant Title

Bon Voyag

Select the cedl range that contains
he data you want to chart. Click the Insert tab on
the nbbon, Cick a chart type button in the Charts

it. Or, chick and drag & sizing handle © to resze

Change 1
I
button and select a dfferent chart

it Chaet With the chart you want 10 flter
selected, chck the Filter 7’ button next to i
Desetect the items you want 1o hide from the chart
view and cick the Apply button

! L L Select the chan, cick
the cnm Eumu button. clck the Legend

button, and select a position for ihe legend

C  Hk hart Emments. Select the chart
and click the Chart Elements ~ bution. Then
use the check boxes to show or hise each
cloment

1 chan where you want
%3 0 trenciing. Cick the Design tab on the

riobon and chek the Add Chart Element

button. Sedect Trendline from the menu

Click the togic links for free lessons!

Excursio

summarize, C ._h |hr-lnmun
sparkling you want to Insert. In the Location Range
r the cell or cell range 1o place the

the Page Layout tab
n and select a page ske

Select the cell range you want
to pont, C m the Plgo Layout tab, cick the Print
Areald button. and seect Set Print Area

Punt Tales, Gadines_and Headings: Cick the
hgo I..you tat. Click the Pvlnlﬂllnl o
and set whch items you wish 1o prnt

Hende f Click the Insert tab and
cick the Header & Footer [] buttcn. Complete the

header and footer Selds.

) Click the M
MMU button to select
from a ist of common page margns. Cick the

Orlentation T button to choose Portrait of
Landscape cnentation

Free Cheat Sheets
Visit

Chart Options
Chart Types

Column: Used 1o compare
afierent values ically side-by-
sde. Each value is represented in
the chart by a vertical bar.

{ Une: Used 10 dlustrate trends
ser time {days, months, years)
Each vaiue is plotted as a pont
on the chart and values are
connected by a Ine

values for
representad by different colors.

Bar: Siméar to column charts,
pl they display information in
S rather than in

ues using sngle
ftiple tems
plotted by using different colored
points or different point symbols

|| Stock: Effective for 'qoﬂ g the
fluctuation of stock , such
as the high, low, and closing
points for a cenain day

Surfac il for finding
PUMUM COMDINAtons Detween
twe of data. Colors and
patterns indicate values that are
N the same range

Additional Chart Elements

Data Labels: Display vakes from e cels
of the worksheet on the plot area of the
chan

Data Table: A table acded next 1o the
chart that shows the work
chart is ilustrating,

Error Bars: Help you quickly dently
standard deviations and &ror marging.

Trendline: Identifies the trend of the
not actual values.
asts for future cata

Contact Us




+ablea U;Ipublic

Visit the COVID-19 Data Hub to access up-t

Resources

A buffet of materials to help get you started, or take you to the next level.

How-to Videos Sample Data Community Res

Guide to using
the public version
of Tableau

https://public.tableau.com
/en-us/s/resources

Select a video below or click/tz



7=\ DATA
{ INNOVATION
PROJECT

The Data
Innovation
Project

The Data Innovation Project partners witl
work, achieve results,and demonstrate in

affect change and tell compelling stories.



e
E Making Data Talk:
S
. ©
Making Data S A Workbook
Talk ... ke

the best guide
evah!

https://www.cancer.gov/publicati
ons/healthcommunication/
making-data-talk.pdf

U.S. DEPARTMENT
OF HEALTH AND
HUMAN SERVICES

National Institutes
of Health




Contact Us

( THE DANYA INSTITUTE

Central East (HHS Region 3)

ATT

Addiction Technology Transfer Center Network
Funded by Substance Abuse and Mental Health Services Administration

Central East (HHS Region 3)
M H TTC Mental Health Technology Transfer Center Network
Funded by Substance Abuse and Mental Health Services Administration

Central East (HHS Region 3)

=~

=26

=H
70

Prevention Technology Transfer Center Network
Funded by Substance Abuse and Mental Health Services Administration

{.,’.\3) PTTC

Central East (HHS Region 3)

ATTC

.,‘\a Central East (HHS Region 3)
e o) PTTC

\e.d

-

@

Renata J. Henry, Director
rhenry@danyainstitute.org
info@danyainstitute.org

(240) 645-1145

Renata Henry, ATTC Project Director
rhenry@danyainstitute.org

Oscar Morgan, MHTTC Project Director
omorgan@danyainstitute.org

Deborah Nixon-Hughes, PTTC Project Director
dhughes@danyainstitute.org
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https://danyainstitute.org/
https://mhttcnetwork.org/centers/central-east-mhttc/home
https://pttcnetwork.org/centers/central-east-pttc/home
https://attcnetwork.org/centers/central-east-attc/home

